
Graham Relf  -  grelf.net 1

Layers, selections & masks in Affinity Photo 2
This guide describes the use of layers, selections and masks when processing 
digital photographs using the application program Affinity Photo. Illustrations are from 
version 2.0 of the program running in Windows 11. Readers are assumed to be 
familiar with the contents of our previous guide: Affinity Photo 2 - A basic workflow.

Mac users: whenever we mention the Ctrl key you should use Cmd; when we say 
“right click” you should use the Control key and click.
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1 - Layers
Opening an image

On opening an image file it is shown in the Layers panel 
like this:

The layer is shown in blue, meaning that it is the 
currently selected one we are working on. Note that it is 
a “Pixel” layer, as indicated by the     icon, so we can use tools that modify parts of it.

The two little icons on the right of the layer can be clicked. The lock means the image 
cannot be moved around relative to its window. The solid dot means the layer is 
visible. These become more useful when we have more than one layer.

The layer is called Background but it can be renamed by clicking on that name and 
typing something else. This is also more useful when we have several layers.

The History panel indicates that nothing has yet been done to the image.

Duplicate the layer
Select Duplicate either on the Layer menu or on the 
context menu (right-click on the layer). 

Rename the layers so the upper one is called “Original” 
and the bottom one is “Working copy”. Also lock the top 
one by clicking the padlock at 
top right of the whole panel. 
These 2 layers should remain 
aligned.

Then un-dot the upper layer to make it invisible.

This is often a useful thing to do. If we now process the 
lower working copy (make sure it is blue) we can dot the 
original temporarily to view it for comparison.

The reason for putting the original at the top of the layer 
stack is that it will not be affected by adjustment layers we 
are going to put above the working copy.
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A very basic point
The Layers panel shows a vertical stack of layers but you need to envisage that as a 
stack of images behind each other on the screen in front of you. The topmost layer 
shown in the panel is the one nearest to you on the screen. So if that layer contains a 
complete image and it is dotted, so it is visible, then it blocks out all the other layers 
below/behind it (as long as the blending mode is Normal - see page 5).

With similar logic, if an upper layer is an adjustment layer (such as Curves) then its 
effect applies to all the layers under (behind) it. We will see later that it is possible to 
change that, so an adjustment only applies to certain layers.

Replacing sky: 2 pixel layers
The sky in the first image here is rather boring. Let’s 
replace it with the sky in the lower image.

Open the first one and duplicate it as before. Select the 
working copy layer. There are several ways to put the 
second image in the same layer stack:

1. On the File menu select “Place…”. This lets you 
select the image and drag it across our first image. It 
becomes an “Image” layer     above the working copy. 
Right click and “Rasterise…” it to be a pixel layer.

2. File/Open the second image. It has its own tab in 
Affinity Photo. Use Ctrl+A to select it All - an animated 
dashed line surrounds it. Ctrl+C to Copy it. Move to the 
first image’s tab. Ctrl+V to paste.

After renaming the layer to “Sky” the layer stack is like this: 

Notice that the sky layer is not locked and it is not the same 
size as the other image, so we will need to move it and 
rescale it. But not yet.

First drag the sky layer down so it is below (and therefore behind) the working copy.

Highlight the working copy layer again and from the main tool bar choose the 
Selection brush tool:         Wipe it across the boring sky until it is all selected, but 
nothing else is.

Remember that the size of the circular tool can be adjusted with [ and ] keys.

The context toolbar should show “Add” in blue so that if you stop dragging but start 
again the new selection will add to the previous one. There is also “Subtract” if you 
make a mistake and select some non-sky. While adding you can also select the tiny 
bits of sky that are showing through the tower’s window.

When the whole sky is selected press the Del key to delete the sky. You will see the 
underlying better sky layer instead. Play with the visibility dots in the Layers panel so 
you fully understand what you are seeing.
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Ctrl+D deselects, to get rid of the animated dashed outline.

Then we may need to move the sky around to position it better. Highlight it in the 
Layers panel. With both sky and working layers visible, choose the Move tool:

That enables you not only to drag the sky layer around (as long as it is not 
locked) but also to rescale it by dragging the corners of the blue box created by 
the tool.

Adjustment layers
With the working copy layer selected press Ctrl+M 
(or on the Layer menu select New Adjustment 
Layer > and then Curves…). The tone curve 
dialogue appears, with its graph, and the 
adjustment layer is attached to the working copy. It 
is shown in the layers panel as an extra icon, with 
a blue rim to indicate that it, the adjustment, is now 
the current layer to work on, not the pixel layer.

Notice the chevron, >, at the left of the working 
copy layer. Clicking that causes the adjustment 
layer to become visible. The way it is positioned 
means that it only affects the working copy layer, 
not the sky layer.

Sometimes we want an adjustment to affect all of 
the layers below it. That can be achieved by 
dragging the adjustment layer up until it sits in the 
required place, as in the lower diagram here. This 
change can be reversed by dragging back down.

Reminder: it is very easy after this to forget to 
highlight a pixel layer before using another tool 
and then to wonder why the tool seems to have no 
effect (though it may be affecting a mask - 
explained later).

Note for those used to Affinity version 1

The behaviour just described is quite different from previously. It used to be that the 
new adjustment first appeared as shown in the third diagram on this page, affecting 
all layers below it. You then had to drag the adjustment layer down carefully until it 
attached itself to a single layer.

Live filters
Similar to live adjustment layers there are also live filters. There are many of these. 
Examples include noise reduction (“denoise”) and sharpening (“unsharp mask”).  The 
full list pops up on clicking an icon at the bottom of the layers panel (the icons are 
described on the next page). On selecting a filter it becomes a new layer just like the 
adjustments.
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Adjustment or filter?
What is the difference? Adjustments work on each pixel of the image individually, 
adjusting its value without looking at its neighbours. A filter takes into account what is 
going on around each pixel. Filters therefore tend to take longer to apply but on 
today’s fast PCs you will rarely be able to see that. As a user you really don’t need to 
know this. Just see what is available on each list.

Select multiple layers
Holding the Shift or Ctrl key while clicking on layers in the layers panel enables 
several to be highlighted at once. Tools will then affect all of the selected layers. 

Layer panel icons
In order from the left:

• Select all layers

• Create a mask layer - we will come to this later

• Create an adjustment layer - a list pops up for selecting one

• Layer effects - we will not cover because it is more relevant to graphical design

• Create a live filter layer - a list pops up for selecting a filter

• Group layers - with multiple layers selected they can be treated as one. This 
enables you to apply an adjustment to a group of layers - not all and not just one

• Create an empty pixel layer above the current layer

• Delete current layer

Merging layers
The Layer menu has 3 options for merging layers:

• Merge down - if 1 layer is selected and there are others below

• Merge selected - if several layers have been selected

• Merge visible - if several layers are ticked to be visible

The result is a new pixel layer just above the highest one to be merged. Adjustments 
and filters will have been applied where necessary, so they are no longer alterable in 
the merged version.

Removing dust spots
The first image on the right here is a small 
patch of sky (cut from a photo of a hang glider). 
As a displayed image it looks fine. A fairly 
extreme curves adjustment reveals dust spots 
(far right) which might mar a printed version.
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While the curves layer is dotted (visible) select the sky layer and  use the Inpainting 
brush tool to correct the spots. Then either un-dot the curves or delete that layer.

The top bar of the layers panel
There are 4 control elements above the layers. 
These apply to whichever layer (or set of layers) is 
currently selected (highlighted in blue).

The first from the left is Opacity. This can be altered 
either by the slider as shown or by typing a number 
into the entry box. Some photographers use this to 
let a texture photo show faintly through what would 
otherwise be a very flat plain background.

The second element is a very long drop-down list of 
“Blending modes”, the beginning of which can be 
seen here. The scroll bar reveals many more.

The default setting is “Normal” which means that the 
current layer will hide those below (behind) it.

It can be worth experimenting with the various 
possibilities. There is a huge range of possible 
effects, especially if you apply the modes to 
adjustment layers. A whole book could be written on 
this subject. The Affinity Photo Workbook does 
include many examples. We will consider just 3 
cases here.

1. If you have a pair of duplicate layers several 
modes give you heightened contrast. The “Multiply” 
mode is a fairly extreme case.

2. The mode called “Subtract” can be used to get the 
difference between 2 images when subjects have moved, 
as in the heron image on the right. The procedure involves 
tone curve layers too and is fully described on page 12 
(abridged from https://grelf.net/how_subtract.html ).

3. The “Divide” mode provides a very good way of 
correcting colour casts, particularly for night shots where 
the unwanted colour is from street lighting.
 3.1 From the original photo use the eyedropper tool to
        pick a sample of the undesirable colour.
 3.2 Add a pixel layer over the photo.
 3.3 Fill the new layer with the sampled colour.
 3.4 Make the blending mode of the new layer
   “Divide”.

The third element in the Layers panel bar, with a cog wheel icon, leads to a dialogue 
for altering the range of brightnesses affected by the blending. This is going beyond 
the scope of these pages. The help pages of Affinity Photo offer some explanation.

Finally, the lock icon we have already seen on page 1.

https://grelf.net/how_subtract.html
https://grelf.net/how_subtract.html


Graham Relf  -  grelf.net6

2 - Selections
A selection is an area or a set of disconnected areas which limit 
the action of an operation or tool to only affect pixels in those 
areas. The selected areas are outlined by animated black and 
white dashes, like this (the dashes march around the outlines):

If you press key Q the selection can be viewed differently, as a 
transparent mask (a Quick Mask, shown here in red). We will 
come to masks later.

                          Selection tools
Several tools are available. Choose a tool and check
(a) is the current layer     (Pixel),
(b) does it contain the pixels you can select,
(c) is the mode (shown in the context bar, below the menus) suitable?

          or 

Are you starting a NEW selection or ADDing to or SUBTRACTing from a selection?         

Selection Brush Tool
The Brush tool can be dragged around to select an area. We used it before on a sky.

Flood Selection Tool
With the Flood tool (wand) just click on required areas. 
Notice the Tolerance setting above the image: adjust it 
to avoid selecting too much or too little on each click.

Marquee Selection Tool - 4 shapes:

The Marquee tool is simple. Try it on an image, using 
all 4 modes (as above) to see effects.

Freehand Selection Tool (under M)

The Freehand tool (lassoe) has 3 types:

The 2nd type (polygon) is most useful. Click each 
vertex, (Del key to step back if you get it wrong), double-click to close the polygon.
The first type is a true freehand curve which can be tricky to do. The third type is 
magnetic: if there is a clearly defined contrast step (edge) in the image it will try to 
follow that.
Notice hints at the bottom of the screen as you use any of the tools.
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Use a combination of tools
Having used one tool to get most of the selection you can use any of the others in 
add or subtract mode to improve it. I often start with flood or brush then use polygon 
to improve.
More buttons on top bar: Select all | Deselect | Invert selection.
Or use keys: Ctrl+A selects all of an image/layer.
Ctrl+D deselects.    Ctrl+Shift+I inverts the selection.

Refining selections
There are several useful options available on the Select 
menu. All lead to relevant dialogues.

• Grow / Shrink… lets you select how many pixels by 
which to change the size of the selection.

• Feather… lets you set a number of pixels by which 
the selected area will smoothly fade into another 
layer if it is copied. Quite useful.

• Smooth… gets rid of sharp corners in the selection 
(this is less useful).

• Refine edges… we will look at in more detail below.

• Outline… You can select a band, of chosen width, 
around the edge of the selection (hardly useful for 
us, more for graphical effects).

Refining edges
Suppose we wanted to replace the sky in an 
image like this. It is quite impossible to select 
all the spaces between the tree branches by 
hand.

The selection procedure is as follows.

1. Use one of the selection tools already 
described to get most of the sky selected.

2. Invert the selection, so it covers the ground, not 
the sky. The sky is the background, to be 
discarded.

3. Select menu: Refine Edges… to get this dialogue: 

The unselected part of the image (mostly sky) 
becomes covered in a transparent red.

4. Brush over all of the trees (not just the unselected 
gaps). This may be easier if the brush is enlarged. 
The “50px” box at lower left reveals a slider which 
can be pushed up to, say, 300px.
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The areas you brush go pink and when you raise the brush some processing 
occurs. You may need to do this a few times to cover everything.

5. To check what has happened, change the “Preview” drop-down (top right) to 
either “Transparent” or (perhaps better) “Black & white”.

6. When the selection seems to be complete change the “Output” drop-down to 
“New layer with mask”. Apply.

The image and layers then look like this:

And then of course we can slip a sky 
image in as a layer below (behind) 
that, as we did before.

The Refine Selection dialogue does 
have more capabilities, well explained 
here:

https://affinity.serif.com/en-gb/tutorials/photo/desktop/video/334273469

Copy and paste a selection
With a pixel layer highlighted in the layers panel, use menu Edit/Copy or Ctrl+C to 
copy the selected part of the image to the clipboard. Edit/Paste or Ctrl+V to paste it 
as a new pixel layer either on the current image or on a different one. The new layer 
only contains pixels from the selected region, the rest of the layer is transparent.

You can also create a new image containing only the copied selection by using menu 
“File/New From Clipboard” or Ctrl+Shift+Alt+N. If the selected area is not rectangular 
there will again be transparent pixels around it.

Move it
Once you have copied and pasted a 
selected area onto a new pixel layer the 
move tool (V) enables you not only to 
move it around but also to stretch or rotate 
it. Why would you want to? Let’s consider 
an example. 

This image is part of a photo of a roof, 
spoilt by spotlights. We can get rid of 
those but it is not as simple as cloning 
from another part of the image because of 
the curve. We need to copy a part of the 
curved plaster and move and rotate it to fit 
over the lights.

https://affinity.serif.com/en-gb/tutorials/photo/desktop/video/334273469
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First use the freehand / polygon tool to define a shape that goes 
along an unspoilt section, like this.

Copy the selection and paste it as a new layer.

Clicked on with the move tool (V) you get 
a blue outline with circular handles on it:

Highlighted like this the layer can be 
dragged to a new position. The corner 
handles enable it to be scaled but keeping 
its proportions. The handles in the middle of 
the sides of the rectangle enable either the 
horizontal or vertical direction to be scaled, 
changing the proportions.

Most importantly for our purposes the handle 
off to the top enables the layer to be rotated.

So the cut out portion can be dragged and 
rotated to fit over the offending lights but 
keep the pattern of the plasterwork. It may 
be necessary to slightly change the 
proportions to make it fit exactly.

Here is my result:

Using the Move tool

Save a selection shape and reload it
On the Select menu: “Save Selection/To File…” presents a file saving dialogue to 
create a file of type .afselection. At some later time you could then use menu “Select/
Load Selection From File…”

Click & drag the top
handle to rotate

Click inside the box
and drag to move it

Click a corner handle and
drag to scale in proportion

Click and drag a side
handle to stretch/squeeze
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Use a selection as a guard region
When using the clone tool it is all too easy to draw outside the target area but setting 
a selection ensures that the tool can only change pixels in the selected area.

Here is a greatly enlarged detail from a photo. When I took it I failed to notice a 
person standing there. With a polygonal selection area it was easy to use the clone 
tool to copy material leftwards with the grey vertical protected from being overwritten. 

Areas outside the selection may be copied but only pixels inside the selection can be 
changed.

3 - Masks

Convert a selection to a quick mask
In the top bar beneath the menus clicking this icon (or key Q) 
converts a selection area to a mask. Q is for “Quick mask”.

The drop-down indicated beside the icon is a small 
menu of options for how the mask is to be depicted.

By default the mask as an overlay is translucent red:

In this mode you can use painting and erasing tools to 
adjust the selection.

Paintbrush tool (B): Paint in white to add to the 
selection. In black to erase parts. In grey to change 
the opacity (proportionate effectiveness) of the 
selection.

Erase brush tool (E): Always erases from the 
selection.

When done, Q takes you back to the normal view of the 
selected area(s) rather than the quick mask view.
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Mask layers
The quick mask was just a temporary way of changing the shape of a selection by 
using different tools (painting and erasing).

There is a different kind of mask which is created as a layer. We have already met 
one such mask when refining a selection.

We have also met masks without realising it…

Live adjustments & filters have masks
The curves adjustment layer here has a mask. Initially the 
adjustment applies to the whole image. But its mask can be 
edited like any other mask. 

One way to make the mask visible is to Alt-click on the graph icon in the Curves layer. 
That will show the mask, all white. Drawing on that in black will prevent the 
adjustment applying to the drawn regions of the image.

Better though: select the Erase brush tool (E) and use it on the image while the 
Curves layer is highlighted. You will see that the tone curve no longer applies to the 
areas where the erasure occurred.

Suppose the tone curve has improved some areas of the image but looks quite 
wrong in others (grass has gone too bright green perhaps). All you need to do, 
having ensured the adjustment layer is highlighted, is to use 
the Erase brush tool (E) to remove the bad areas from the 
mask. When you have done that it becomes apparent in the 
Curves layer too, as shown here. The black portion was 
erased.

The mask can be inverted (Ctrl+I, or Layer menu/Invert). So if you 
only want to apply the adjustment to certain areas, first invert so the 
mask goes black then choose the paint brush tool (B) and paint in 
white on the areas you want the adjustment to be applied to.

Creating new masks as layers
There is a different approach to the sky replacement we did earlier.

Recap: duplicate the reservoir image, put the better sky below (behind) it, select the 
bad sky in the working copy. But then…

• Invert the selection (Ctrl+Shift+I) so the ground is selected, not the sky.

• Click the new mask icon at the bottom of the 
layers panel.        The working copy layer 
was selected so the new mask is attached to 
that. That layer is now masked.

• Clear the selection (Ctrl+D).

The mask becomes as shown here. The black 
area (sky) is transparent so the better sky is 
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seen behind it.

The advantage of this method is that the selection shape is kept in the layer stack in 
a form that can still be edited again if necessary. Saved in a .afphoto file you can 
bring it back any time for amending.

Appendix

Subtracting one photo from another (further to page 5)
If you put each photo on a different layer one of the possible blending modes for the 
upper layer is Subtract. However, that by itself will not produce the desired result.

If the range of brightnesses in each image (pixel values in each colour channel) is 
from 0 to M (maximum) then subtracting one image from another produces a possible 
range from -M to +M. (think about it: M - 0 = +M but the other extreme is 0 - M = -M). 
Neither Affinity Photo (AP) nor Photoshop (PS) is able to display negative pixel 
values. Such values all become zero, shown as black. Everything that was brighter in 
the second, subtracted, image than it was in the first image will become black.

We need to have a Curves adjustment layer for each image. This must be a different 
one for each image and only affect that image, not both of them.

We need to adjust the initial straight line in each curves diagram. For the lower layer 
(to be subtracted from) the left end of the line has to be dragged up half-way, so the 
pixels go from M/2 to M. For the upper layer the right end of the line must be dragged 
down from M to M/2. Then subtraction will produce the range 
from 0 to M. Things which are unchanged between the two 
images will appear as mid-grey, at M/2 for all colour channels. 
Other pixels will be brighter or darker depending on whether they 
were brighter in the first or second image.

Shown on the right is the curve setting for the subtracted image 
(upper layer in the layers panel). The red line was the original. 
The blue line has had its right end dragged down half way. This 
applies to all 3 colour channels.

This technique is suitable when two photos 
have been taken with the same exposure 
settings and with the camera fixed (eg, on a 
tripod) but something in the scene has 
moved or changed in some way. Subtraction 
shows only things which changed. Fix the 
camera and use manual settings to take two 
photos. Automatic settings might be different 

for each image, so manual is best. Fixing the camera ensures that an unchanging 
background will be the same in both photos (except for possible noise if a high ISO 
setting was used). In this example there was some breeze causing the foliage and 
water to move slightly, which makes an embossed effect.


